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============================================================= 
Welcome to the English Academic Technology Bulletin. This monthly 
publication of the English list communicates basic information regarding the 
use of technology in the preparation and imparting of instruction. The 
English list is a close, moderated list restricted to the staff of the 
English Department of the College of Humanities of the University of Puerto 
Rico, Rio Piedras campus and other authorized users. If you are interested 
in subscribing to the English list or contributing content to the bulletin, 
please notify Alicia Pousada (apousada@earthlink.net), the list moderator. 
To post to the list, just Reply to this message. Remember that what you post 
will go to every subscriber. 
 
=========================================================== 
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================================ 
ANNOUNCEMENTS 
 
On September 19th, a highly entertaining and educational workshop was given by 
Arturo Géigel,  computer security officer for the Government of Puerto Rico, and 
his wife Gina Colón, web site designer.  Ten participants (including two graduate 
students) enjoyed learning about how cybercrime is committed and what they 
could do to protect themselves from it. 
    * * * * 
 
The next Academic Technology workshop will be presented by Jo Anne Harris on 
October 24 from 1 pm to 3pm. It will cover the topic of Computer Trouble-
shooting.  A sign-up sheet will be posted on the English Department door. 
 
    * * * * 
The ASPIRA Association and the Council for Opportunity in Education will be 
hosting the fourth annual "Technology Tools for Instruction and Management 
Conference", December 7-10, 2003 at the Wyndham El San Juan Hotel, Isla 
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Verde, Puerto Rico. Keynote speakers include Congressman Bob Menendez, 
Ruz Hudnell, Senior Vice-president of Intel Corporation, Gabriella Morris, 
President of The Prudential Foundation and Antonio Garcia-Padilla, President of 
the University of Puerto Rico. The event features over 50 concurrent sessions 
and hands-on computer lab demonstrations. 
 
Puerto Rico residents receive a special discounted conference fee ($350). This 
includes all sessions, two breakfasts, two lunches, a reception, and all written 
materials. There is also a day of pre-conference workshops for $300.  For more 
information and online registration, please visit www.technologytools.org 
 
  *   *   * 
 
On October 17, from 8:30 am-12:00 noon, the Centro de Excelencia Académica 
will be sponsoring a workshop on the use of computer technology to create 
student-centered educational environments.  Presenters will be:    Dr. Gerardo 
Morell,    Dr. Manuel Reyes Guzmán,    Sr. Víctor Ortiz (all from General 
Studies) and    Dr. Noel Motta, of Natural Sciences. The session will be held in 
Room C-236 in the Natural Sciences Building. For more information and to 
confirm your attendance, please call the Centro de Excelencia Académica at 
extension 2964, 2963, or 2962, or send an e-mail to: 
centexa@rrpac.upr.clu.edu. 

 
============================================= 
 
USING TECHNOLOGY IN THE CLASSROOM 
 
Editing student or collegial work with Word 
 
When  students or colleagues give you their work to read in electronic form, you 
have several editing options in Word that will speed up the process and make 
changes visible and easy to implement.  
 
The first is the Insert menu which includes Insert Comment. To use this, highlight 
the word or phrase that you want to comment on, then select Insert -> Comment.  
Write your comment in the box at the bottom, and then click Done. The text will 
be highlighted where there are comments. The student can move a cursor over 
the highlighting to read the comment or right-click the mouse to edit or delete the 
comment. Your comments can be as long as you wish, and the writer's text is not 
torn up by the comments. Your comments can also be edited at will.  
 
Another helpful option is Track Changes. This feature of the Tools menu gives 
you a visual record of any changes made to a document. Go to Tools  Track 
Changes  Highlight changes. Turn highlighting on by putting a check mark in 
the Highlight Changes box. Until you turn Track Changes off, you will see 
additions and deletions marked in different colors which you can select. When 
the writer reads the edited version, then he or she can decide to accept or reject 
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changes by clicking on the appropriate choices in  the Track changes menu. 
Once a decision is made, the highlighting disappears. Warning:  if you want to 
delete a change that you’ve accepted, you’ll have to turn Track Changes off. 
 
AutoSummarize  lets you open a document and prepare an automatic summary 
of its contents by clicking on Tools  AutoSummarize. There are various options 
for positioning the summary. The summaries are not great literature but they may 
come in handy as a starting point for abstracts. 
 
 
 
 
Bargain Book Closeouts 
 
If you or your students are in need of a source of inexpensive books and DVDs, 
try Bargain Book Closeouts.  http://www.bookcloseouts.com  They have a huge 
inventory, and while some of the books may be a bit shopworn around the edges, 
they are always intact and quite usable.  You can also request a printed 
catalogue which is guaranteed to keep you occupied for the better part of a 
week. 
 
ERIC Digest (Dec. 1998) 
 
“Using the World Wide Web with Adult ESL learners” by Kathleen Flannery is an 
excellent article explaining how the ESL instructor can make use of  many on-line 
resources to further the English development of his/her students.   
Go to:   
http://esl.about.com/gi/dynamic/offsite.htm?site=http%3A%2F%2Fwww.cal.org%
2Fncle%2Fdigests%2FWWW.htm 
 
 
Using e-mail in writing classes 
 
“Let the E-mail Software Do the Work: Time Saving Features for the Writing 
Teacher” by  Ron Belisle of the Mukogawa Fort Wright Institute, Spokane, 
Washington is an excellent article that  examines how most e-mail programs can 
save the teacher time organizing, filing, retrieving, and responding to student e-
mail writing assignments. It details the steps for downloading a freeware e-mail 
software program (Eudora Light), installing it up on your computer (Mac or 
Windows), and helping you set-up some of these time-saving features.  
http://iteslj.org/Techniques/Belisle-Email 
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NEW DEVELOPMENTS IN TECHNOLOGY  
 
The Digital Time Machine shortens audio and video recordings by up to 12 
percent with "no discernible results,” according to the New York Times 
[http://www.nytimes.com/2003/10/02/technology/circuits/02spee.html?8cir] . 
Some broadcasters are reported to be using this micro-editing technology to 
squeeze more advertisements into the same block of time. Typical spoken 
language is at the rate of 140 to 180 words a minute. However, most humans are 
able to comprehend speech that is 2 to 4 times as fast. This has interesting 
implications for the educational audio book industry. For more information, go to: 
http://www.primeimageinc.com/Digital_Time__Machine_Spec.htm 
 
 
============================ 
MACNUGGETS 
 
Shortcuts for using the Finder in Mac computers 
 
Select an icon by name: Type the icon's full or partial name 
Select the next icon alphabetically: Tab 
Select the previous icon alphabetically: Shift-Tab 
Select the next icon up, down, left, or right: Up arrow, down arrow, left arrow, or 
right arrow 
Select the startup disk: cmd: Shift-up arrow 
Select multiple icons: Shift-click each icon or Shift-drag across the icons 
Begin editing the selected icon's name: Return or Enter 
Insert at the beginning of a selected icon name: Up arrow 
Insert at the end of a selected icon name: Down arrow 
Move the insertion point in a selected icon name: Left arrow or right arrow 
Align (or don't align) icons or buttons (countermands View Options or Views 
control panel setting): cmd-drag icon or button, Options, or Views 
Copy an icon to the desktop or another folder: Option-drag on the same disk 
Make an alias (Mac OS 8Ð8.5 only): cmd-Option-drag 
Move selected icons to the Trash (Mac OS 8Ð8.5 only): cmd-Delete 
Open the selected icon: cmd-O or cmd-down arrow 
Open the selected icon and close the active window: cmd-Option-O or cmd-
Option-down 
Open the selected icon's enclosing folder or disk: cmd-Up arrow 
Open the selected icon's enclosing folder or disk: cmd-Option-up arrow and close 
the active window 
Open an enclosing folder or disk of the active window: cmd-click the window title 
and then choose from the pop-up menu 
======================================== 
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Mac downloads 
 
For a long list of free downloads just for Macs, go to: 
http://netguru.ch/macintosh.htm 
 
   *  *  *   
 
Clean up as you go 

As you navigate through folders, hold down the [option] key to close the current 
folder as you open the next one. This keeps your desktop tidy and prevents you 
from having to go back and close a trail of folders.  

   *  *  *  

Chats 
 
Apple's iChat lets you save text chats for future reference in the Documents: 
iChats folder in your user folder. However, these logs aren't very useful for 
finding something typed during a chat.  To make searching chat transcripts 
easier, try Spiny Software's free Logorrhea (http://www.spiny.com/logorrhea ). 
While the name is fairly repugnant, this product is actually fun and useful. It lets 
you access iChat logs in two ways. Via the Browse tab, you can browse chats by 
user name and the chat's date and time. Once you select a chat, you can read 
the exchange and view each user's messages color-coded. An even more 
rewarding technique is to use the Search tab. If you type in a word or phrase, 
Logorrhea will finds all the chats that contain that phrase and even highlight the 
search term for you in the chat.   
 
==================================================== 
 
USEFUL DOWNLOADS 
 
Yeah Write is a simple, powerful, attractive, and highly useful word processing 
program that you can get for free in truncated version or in full version for only 
$29. It is fully compatible with Word if saved in Rich Text Format. Run, don’t walk 
to: http://www.yeahwrite.com/yw_downexe.shtml for the download. 
 
    *  *  * 
Doublecheck your AntiVirus program with the free, online-only scanners available 
at www.pandasoftware.com/activescan and http://housecall.trendmicro.com. 
 
    *  *  * 
Palm Pilot users who are tired of using Graffiti may want to try Handwrite. This 
free downloadable program adapts to your own handwriting style and saves you 
time by not forcing you to learn Graffiti style. There are three writing thicknesses 
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to choose from,  and you can time-stamp your entries.  Go to: 
http://www.pcworld.com/downloads/file_description/0,fid,8412,00.asp 
 
    *  *  * 
 
To back up your DVDs onto your hard drive, try DVD Shrink. The free download 
is available at:  
 
http://www.pcworld.com/downloads/file_description/0,fid,23009,tk,hsx,00.asp 
  
 
============================================= 
 
CYBERHUMOR 
 
Strunkenwhite:  New Computer Virus  

A new computer virus is spreading throughout the Internet, and it is far more 
insidious than the Chernobyl menace. Named Strunkenwhite after the authors of 
a classic guide to good writing, it returns email messages that have grammatical 
or spelling errors. It is deadly accurate in its detection abilities, unlike the dubious 
spell checkers that come with word processing programs.  

The virus is causing something akin to panic throughout corporate America, 
which has become used to the typos, misspellings, missing words, and mangled 
syntax so acceptable in cyberspace. The CEO of LoseItAll.com, an Internet 
startup, said the virus has rendered him helpless. "Each time I tried to send one 
particular email this morning, I got back this error message: 'Your dependent 
clause preceding your independent clause must be set off by commas, but one 
must not precede the conjunction.' I threw my laptop across the room."  

A top executive at a telecommunications and long-distance company, 10-10-10-
10-10-10-123, said: "This morning, the same email kept coming back to me with 
a pesky notation claiming I needed to use a pronoun's possessive case before a 
gerund. With the number of emails I crank out each day, who has time for proper 
grammar? Whoever created this virus should have their programming fingers 
broken."  

A broker at Begg, Barow, and Steel said he could not return to the old days when 
he had to send paper memos in proper English. He speculated that the hacker 
who created Strunkenwhite was a "disgruntled English major who couldn't make 
it on a trading floor. When you're buying and selling on margin, I don't think it's 
anybody's business if I write that 'i meetinged through the morning, then cinched 
the deal on the cel phone while bareling down the xway.' "  

If Strunkenwhite makes emailing impossible, it could mean the end to a 
communication revolution once hailed as a significant timesaver. A study of 
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1,254 office workers in Leonia, N.J., found that email increased employees' 
productivity by 1.8 hours a day because they took less time to formulate their 
thoughts. (The same study also found that they lost 2.2 hours of productivity 
because they were emailing so many jokes to their spouses, parents, and 
stockbrokers.)  

Strunkenwhite is particularly difficult to detect because it doesn't come as an 
email attachment (which requires the recipient to open it before it becomes 
active). Instead, it is disguised within the text of an email entitled  
“Congratulations on your pay raise." The message asks the recipient to "click 
here to find out about how your raise effects your pension." The use of "effects" 
rather than the grammatically correct "affects" appears to be an inside joke from 
Strunkenwhite's mischievous creator.  

The virus also has left government e-mail systems in disarray. Officials at the 
Office of Management and Budget can no longer transmit electronic versions of 
federal regulations because their highly technical language seems to run afoul of 
Strunkenwhite's dictum that "vigorous writing is concise." The White House 
speechwriting office reported that it had received the same message, along with 
a caution to avoid phrases such as the truth is and in fact. Home computer users 
also are reporting snafus, although an emailer who used the word snafu said she 
had come to regret it.  

The virus can have an even more devastating impact if it infects an entire 
network. A cable news operation was forced to shut down its computer system 
for several hours when it discovered that Strunkenwhite had somehow infiltrated 
its TelePrompTer software, delaying newscasts and leaving news anchors nearly 
tongue-tied as they wrestled with proper sentence structure.  

There is concern among law enforcement officials that Strunkenwhite is a 
harbinger of the increasingly sophisticated methods hackers are using to exploit 
the vulnerability of business's reliance on computers. "This is one of the most 
complex and invasive examples of computer code we have ever encountered. 
We just can't imagine what kind of devious mind would want to tamper with 
emails to create this burden on communications," said an FBI agent who insisted 
on speaking via the telephone out of concern that trying to email his comments 
could leave him tied up for hours.  

Meanwhile, bookstores and online booksellers reported a surge in orders for 
Strunk & White's The Elements of Style.  
   

---By Cybersatirist Bob Hirschfeld of Bob's Fridge Door  
Accessed at: http://www.mcsdtechcenter.org/humor/strunk.htm 
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